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The details you're wanting to know:
At the combined November/December General Meeting of the Licking County
Computer Society on December 7th at 2:00 p.m.; we will be meeting for a Potluck
and Annual Business Meeting.
M ost important: We start eating at 2:00 p.m. Bring and setup your dishes by
1 :52 p.m. so we can h ave things ready to start eating at 2:00 p.m.
LCCS will provide the meat (fried chicken), table service, and drinks (if you have a
favorite legal beverage that you'd rather have, BIY).
You will provide some delicious side item/dessert, etc... to go along with our chicken. If you'd
like to bring a guest, please let us know (so we can grab an extra piece of chicken) and just bring another side
item for them.
After dinner (or towards the end) we will have our Business Meeting to elect officers and
anything else that needs the groups attention.
Following the conclusion of business, we will have the drawings for the three raffle items (listed
in a previous message). Tickets are $1 .00 each and can be bought during any LCCS function or the day of
the potluck until the seller is ready to eat. Oh, and some lucky member will be getting a free (that's a Free
John kind of deal) raffle ticket that might win you one of the prizes.
To find out if you are the lucky winner, you just need to find your name listed somewhere in the
December Random Bits newsletter (and not in reference to any articles) that will arrive in your inbox prior to
the dinner If you are the lucky winner be sure to see Mary Frances for your prize.

See the "News and Events" sections of the newsletter for more details.
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P revious P rogram P oints

We are still looking for a reporter that would be willing to provide us with an outline over
view of the previous month's presentation. The outline would include the main points that the
presenter made during the Program part of the meeting.

* Clcik on the link to the right to see a video of Past Programs and Meetings LCCS Media

The Soapbox

Apparently there is no one that has any thing to say this month.
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News and Events

We're Getting a New Name

At their last meeting, the Executive Board of the Licking County Computer
Society (aka LCCS) received a motion, discussed it throughly, and voted in
favor of renaming themselves (to expand their service area and to better
align our goals and mission) to the East Central Ohio Technology Users
Club (ECOTUC, 'ECO TUC').
We discussed the following misconceptions about the current name:
Licking County = makes people think that you have to live in Licking County to be a member. We don't
want to restrict living location. In the past, one member ask if they had to resign their membership
because they were going to move just across the Licking county line.
Computer = makes people think that if you are not a “computer” user you can't be a member. We
have a number of people active in the iPad group that do not (or no longer) use a traditional
computer. We don't want to keep interested people out.
Society = makes people think we might be a serious, inclusive, highly knowledgeable type of group
and wouldn't want computer users of all levels, especially the beginners.
With the new name, we think people would better understand who we are and what we do:
East Central Ohio = this allows anyone from this area (which can go from east of Columbus to as far
as Cambridge, and south from Logan/Lancaster clear north to Mt. Vernon/Mansfield) if desired, to
become an active member. Is there another group besides the one in Columbus for our area of the
state? Could expanding our area, increase our membership? If people are willing to drive, shouldn't
they be included?
Technology Users = this will include ANY type of technology someone uses. As mentioned, the iPad
group is doing well and we think we have people that would like a Tablet and/or Smart Phone
SIG/Help Desks (if we could find leaders). Could expanding our focus, increase our membership?
Maybe we could get some technology students from the area colleges as members and resources for
us?
Club = as defined: 2. a group of persons organized for a social, literary, athletic, political, or other
purpose: 4. an organization that offers its subscribers certain benefits, as discounts, bonuses, or
interest, in return for regular purchases or payments: 1 8. to combine or join together, as for a common
purpose. ALL of which we provide and do.
In order to simplify some of the legal issues with our group, we would keep the name Licking County
Computer Society in the background for a while (tax free status, banking accounts) and make
changes when possible. Officially we would be registered as the Licking County Computer Society
doing business as the East Central Ohio Technology Users Club, but in public we will now begin
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referring to ourselves as just ECOTUC (for short) and the East Central Ohio Technology Users Club.
The Executive Board understands that it will take some time getting used to the new name; but for
this group to continue into the future, we need to embrace the new name and this new direction in
which we need to go. Our hope is to not end up like a number of other computer groups (dying,
disbanded, or dead) that couldn't/wouldn't evolve into something that meets current needs.
Submitted by the Executive Board of the East Central Ohio Technology Users Club

December General Meeting Details

After enjoying some good food, we will elect officers for the 201 5 calendar year, and
any other necessary business presented by the Executive Board. Following the business meeting we
will draw the winners for our big raffle.
As in past, the Nomination Committee puts together a slate of officers with at least one (1 ) candidate
for each office. Anyone interested in stepping up and volunteering their time and talents for any office
(all executive board offices are open) can contact the Committee Chair - Carolyn Clark
(cjclark1 0@windstream.net) to submit names. Candidates can also be nominated from the floor at
the meeting.
The slate of officers being presented by the Nominating Committee are:

President: Jim Amore
Vice-President/Program Chair: Mary Frances Rauch
Secretary: Nancy Grower
Treasurer: Waneta Newland
Trustee (201 5-201 7): Wayne Snyder
There are two other trustees (Vicky Atkins and Bob Vance) that are serving unexpired
overlapping terms
If anyone else is interested in serving, please contact Carolyn.
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In addition to all the great food that we will be eating at the Annual Election Potluck, we will be having
another great RAFFLE.
We have three (3) prizes. They are (first ticket drawn gets choice which one, second ticket drawn
picks from remaining two choices, and third ticket drawn gets whatever is left):

1 . Western Digital, My Passport Ultra Portable hard drive, one (1 ) Terabyte in size, USB 3, (has
USB cable).
2. Lexar Jumpdrive S23, 64 Gigabyte in size, superspeed USB 3.0 (includes key ring)
3. PNY Flash Drive, 32 Gigabyte, USB 2
Tickets are $1 .00 each, and needs your name on back of ticket stub.
Drawing on December 7, 201 4, immediately after dinner and the elections.
Tickets can be purchases beginning Friday, November 1 4th at all LCCS functions at the Technology
Resource Center (1 23 S. 3rd St.). This includes Friday morning at the Windows Help Me/Show Me
session and Friday afternoon at the Linux Help Desk; and Saturday afternoon at the Repair Help
Desk just for starters (check your calendars for other activities). The more you buy, the better your
chances are at winning one or more of the prizes. The lucky winner of the "free ticket" is George
Willey!

Club Members Recognized for Service
In a double surprise presentation, the m embers of the Neal Ave. United Methodist Women's group
recognized David Rauch with a Special Mission Recognition for his service to Neal Avenue United
Methodist Church. As of December 201 4, Dave will have served as a treasurer for 50 consecutive
years as Sunday School Treasurer, Church Treasurer and Assistant Treasurer. He also helps with the
computers and sound system during the services. His wife, Mary Frances, helped surprise him and
then was surprised herself when she too was awarded a Special Mission Recognition for her being
vital the the Neal Avenue UMC for her service and commitment to the food pantry and helping those
in need. Congratulations from your computer club family on these recognitions.

Club Member Appointed National Advisor
LCCS' own John "Free John" Kennedy has been appointed by our parent group, the Association for
Personal Computer User Groups (APCUG), to fill the unexpired term as APCUG Advisor for Regions
6 and 7 (Midwest and Upper Plains). His region runs from Indiana/Michigan/Kentucky west to N/S
Dakota/Nebraska and the states in between. Like our other club member, Bob Vance (Region 3
Advisor: Ohio, PA. and WVa), his responsibilities are to be the link between the member groups in
those states and the national organization providing help and keeping the lines of communication
open. LCCS thanks Free John for stepping forward to fill the need where there was no Regional
Advisor.
Random Bits

Page:

5

News and Events

LCCS Officers Thanked For Their Service

As this calendar year comes to a close, LCCS wants to thank the current officers and appointed
voting board members; Jim Amore, President; Mary Frances, Vice President/Program Chair; David
DeRolph, Secretary; Waneta Newland, Treasurer; and our Trustees: Ira LaFollette III, Bob Vance, and
Vicky Atkins; Jim Amore, Director of the Recycling Program and John Kennedy, Director of the
Teaching Program for volunteering and giving of their time and service helping lead our group.
Without their leadership, many of the benefits of belong to the Licking County Computer Society
would not be available.
Also thanks go out to our non-voting appointed executive members: Membership - Vicky Atkins,
SIG/Help Desk Leaders: Everett McKee (Repair), David Clement (Digital Image), John Kennedy
(Windows Help Desk), Ken Bixler (Linux Help Desk and the BYOC workshops), Chuck Tyndall (iPad
Help Desk), Rich Allen (Newsletter editor), David Rauch (program audio/visuals and door prizes),
Mary Frances Rauch and her whole team (for snacks/refreshments during our social time before our
meetings) and special thanks to Bill Toothman for all the help in checking out the computers for
Refurbishing/Recycling. If we forgot anyone, we'll list them in the next newsletter.
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News and Events Con't

For the latest information on Events "Click" on the link below
LCCS Google Calendar
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Cartoon Source:CLICK HERE

Cartoon URL: CLICK HERE

SIG Help Desk Reports

Repair SIG / Help Desk

11 /1 5/201 4
Meeting Times

First Saturday 1 :00 - 4:00 p.m.
First Tuesday 7:00 - 9:00 p.m.
Third Saturday 1 :00 - 4:00 p.m.

Today was a busy day. We had two cases of virus infections, a problem
accessing Windstream email and a Linux build/transfer of old files.
Jim Amore and Ron Simms worked on virus infections.

Everett McKee corrected an email account access problem. All software worked properly but, login
failed at Windstream.
Ken Bixler installed Linux (Ubuntu 1 4.04) on a refurbished computer. Two fresh hard drives were
used. One of the old drives (system) was experiencing partial failure. It was running so slowly that
the system files couldn't be loaded. Two user accounts from the old computer had to be copied to
the other new drive.
Ira LaFollette/Ken Bixler
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SIG Help Desk Reports

Windows Help Me / Show Me

Although not big in numbers, we did provide helpful service to a number of
people with Windows questions. We had three "helpers/showers' and we
worked with six or seven people with needs.
Among the different things we helped with or showed how to do included:
Meeting Times
helping see how to make the print larger when trying to print something from
Second Friday 9:00 - 11 :1 5 a.m. Facebook; how to save (File/Save As webpage) both web sites and things off of
a web page (copy/paste to document) in special folders within your home folder
on your computer for later retrieval; how to transfer files off thumb drives or
CD/DVDs and into your computer; how to make a program the default program so when you click on a
specific file type it opens in the program you want (not what Windows wants); and a few assorted tips on
doing things in the new Windows Start Page.
The bonus help turned out to be a cross-platform issue where a member was having problems
updating an iPad using iTunes on a Windows laptop. The update had stalled and there was problems trying
to recover the iPad. After much investigating and trials, it was discovered that the firewall on the laptop was
blocking a necessary download (although other downloads happened without issue) that prevented the iPad
from completing the upgrade. After the firewall was turned of for a short period of time, the needed download
was completed and the iPad was restored to working order.
The Windows Help Me/Show me will meet again in December and then determine what will
happen over the remaining winter months of January and February.
S ubmitted by John Kennedy, Windows Help Me/Show Me "host

Linux SIG / Help Desk

The meeting began with a look at a surprisingly new addition to the
Ubuntu family with the addition of a version that uses the MATE desktop
environment. Up to now, Ubuntu didn't feel the need to have that version
until it became so popular. We took it for a short test spin and from the
Meeting Times
reactions of the members, it has strong possibilities of becoming very
Second Friday 1 :00 - 4:00 p.m. popular. MATE was a strong desktop version of the Linux Mint operating
Fourth Friday 1 :00 - 4:00 p.m. system (sort of a competitor of Ubuntu) and many Ubuntu users had
switched over to Mint because of MATE. At our next meeting on the 28th,
we will do a "side-by-side" comparison of Linux Mint-MATE and UbuntuMATE to see if one appears better than the other?
While going back and forth between Ubuntu-Unity (the default desktop environment)
and Ubuntu-MATE, we did a side trip to review the Xfce desktop environment.
The next part of the program, Ken shared with us the solution he used to recover data
from a dying hard drive. The drive was over-heating causing it to shut off. Replacing the hard drive
was no problem nor installing an operating system, but he had a real challenge in recovering the
important data off the old drive (the user had not backed up any data files). One trick to dealing with
dying hard drives is to put it in the freezer to help loosen parts, but as soon as the drive warmed up it
started to fail. He came up with a very unique process to keep it cold. He placed the hard drive
(connected to the computer) in a plastic bag and got out as much air as possible so the bag touched
the hard drive. Then he lowered the bag containing the hard drive into a pitcher of ice water. This
method seemed to work and he was able to copy the data files off the drive in small periods of time.
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As the ice melted and the water warmed up, he had to keep adding more
ice to keep the temperature cold. He was able to recover most of the files
after a couple of days (many, many hours) of repeating the process. The
bottom line is that backing up your important files is the #1 thing everyone
should do.
Meeting Times
The last part of the program, Ken talked to the group about creating a
Second Friday 1 :00 - 4:00 p.m. backup plan using one of the Linux programs called Cron and crontabs.
Fourth Friday 1 :00 - 4:00 p.m. This is a command line program and can be customized very easily to
backup just what you want, when you want it. The plan he helped a
member set up was to backup new files everyday (the program can tell
what's old and what's new), then at the end of the week a weekly backup was created. This is
repeated each week until the end of the month when a monthly backup is created. Then the whole
process is repeated with daily backups of new files, weekly backups, and another monthly backup.
The master plan goes for three months and then recycles itself which then overwrites old backups
with new backups. What this means is that if you need to find an old file, you can go back as far as
three month's later and find what you need.
As you can see, there's a lot of learning going on with the Linux group. We meet the
second and fourth Friday afternoons and everyone is invited to come and learn more about the FREE
Linux operating system.
Submitted by Ken Bixler and John Kennedy, Linux Help Desk Co-Hosts

Digital Imaging SIG / Help Desk
Submitted on behalf of David Clement
For the November meeting we had planned a hands on Close up / Macro
photography session. Each member was going to use their own camera
Meeting Times
and become familiar with the Macro setting on their camera. We were
Second Tuesday 7:00 - 9:00
going to set up three different locations with different objects for them to
p.m
photograph.
But due to the illness of the presenter/leader we had to cancel the photo
shoot for November. But never fear we have rescheduled the photo shoot
for the December meeting. So we hope that all the SIG members will be able to attend and get some
practice using the Macro setting on their cameras.
For the New Year we are looking at a couple of demonstrations in the first couple months. Such as a
presentation by David Rinehart on a multimedia production program, photographing pouring water,
and another on photographing fire/flames. We hope that the Digital Image SIG members will be able
to make it. We also would like to invite other members of the computer society, as well as any new
members.
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iPad / iDevice SIG / Help Desk

At the November session, David Reinhart showed a movie
he made from pictures and video clips from a recent vacation. The movie
was made on a PC and transferred to the iPad through iTunes and was
Meeting Times
displayed to the group on the overhead projector through the Apple TV
Third Tuesday 7:00 - 9:00 p.m device. We also talked about backing up the iPad to iCloud and talk about
the advantages of doing the backups this way. We looked at the “Find my
iPad” app and plan to look at it further in a future session. The group will
meet again on December 1 6th.
Submtted by Charles Tyndall
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Featured Articles

Utilities & Programs That You Need For Your Computer

VTC Presenter:
David Williams
VTC Presenter Title:
Secretary, Online Services and Programs, Central Iowa Computer
User Group
APCUG Virtual Technology Conference Saturday, 201 4, November 1

VTC Presentation Description:
Ever wonder how fast your computer is actully running? Do you wonder what type of motherboard
you have? Do you want to know the best way to clean up your regisrty? How about what wireless
networks are runing in your neighborhood? How about how to clean up all the temporay junk files on
your computer or how to down load a video from YouTube.
VTC Handout:Must Have Utilities - APCUG 11 -1 -1 4 VTC - David Williams
VTC YouTube Video Link: Click Here
APCUG Virtual Technology Conference Link: Click Here

Windows 1 0

VTC Presenter:
Francis Chao
VTC Presenter Title:
Member, WINNERS and GSBUG, CA + Tucson Computer
Society, AZ
APCUG Virtual Technology Conference Saturday, 201 4, November 1

VTC Presentation Description:
The "Start Menu" is back and it has been enhanced with a column of "Start Screen" tiles in addition to
the original menu selections. Francis always likes to be on top of the latest and greatest and this will
be your opportunity to see what’s good (or not) about Windows 1 0. Why is it Windows 1 0? What
happened to 9? So far, we’ve had: Windows 1 , 2, 3, 95, 98, 2000, ME, XP, Vista, 7, 8, & 1 0.)
VTC Handout:Win1 0 Tech Preview - APCUG 11 -1 -1 4VTC - Francis Chao
VTC YouTube Video Link: Click Here
APCUG Virtual Technology Conference Link: Click Here
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Folders, Networking & Storage

VTC Presenter Title:
Secretary, Online Services & Programs, Central Iowa Computer
User Group
APCUG Virtual Technology Converence Saturday, 201 4, August 1 6

VTC Presentation Description:
Folders are not just for “My Documents” anymore, you can store files anywhere
you want to. We will show you how to set up a network, set up storage devices and to organize your
folders.
VTC Handout: Folders, Networking & Storage-David Williams
VTC YouTube Video Link: Click Here
APCUG Virtual Technology Conference Link: Click Here

1 0 Tips for Online Shopping Safety
By Sandy Berger, CompuKISS
www.compukiss.com
sandy (at) compukiss.com

Amazingly, in today's topsy-turvy world, because of vulnerabilities in the processing of
credit and debit cards used at retail stores and the hackers who are focusing on those vulnerabilities,
right now shopping online can actually be safer than swiping your card at a local store. For safety
sake, however, there are a few online shopping rules that you should follow.
1 . The first of these is to always have a good antivirus program installed on your computer and to
update your antivirus program and other software like the operating system whenever an update is
available. When in doubt, don't click on links. This is especially true of email where phishing schemes
are prevalent, but you should also be careful when you are surfing the Web or visiting social media
websites.
2. Shop at trusted, established websites. Don't use any sites that you've never heard of. If you want
to try a new website, check to see if any friends or acquaintances have used it successfully.
3. Pay only through secure sites. Typically the address in your browser will change from "http:" to
"https:" during a secure connection.
4. Never email your credit card number, social security number, or personal information to anyone.
No reputable seller will request it by email since email is not secure.
Con't
Random Bits
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5. Do your banking and shopping from home where you are on your own secure network. Wi-Fi
hotspots at local coffee shops and other establishments usually do not offer enough protection unless
the user takes some added precautions, which can be cumbersome for the average user.
6. Create strong passwords consisting of numbers, letters, and symbols. Do not use words or names.
Make the password for each banking and shopping site unique. Keep your passwords private.
7. Credit cards are generally the safest option for shopping online. When using a credit card, you
have limited liability and the ability to have the credit card company intervene if something goes awry.
Debit cards can also be a good choice as long as you have investigated their liability limits, which
may be higher than those of credit cards.
8. Keep a paper trail. Let's face it, none of us have perfect memories. Print and save records of your
online transactions, including the name of the seller, product description, price, and date of purchase.
Most reputable merchants allow you to print a receipt after the transaction is complete. You can use
these printed receipts to compare to your bank and credit card statements.
9. Monitor your bank accounts and credit card purchases regularly. Report any discrepancies or
unusual charges to your financial institution immediately.
1 0. Your social security number is the key to your identity. Be miserly about sharing it with anyone,
especially online. No reputable merchant will ever ask for your social security number to make a
purchase.
Credit card theft is pretty easy to get through. Usually you notify your financial institution and they
issue you a new card. Identity theft is much more difficult to handle because a thief can open lines of
credit in your name, buy a car, and obtain new credit cards. In order to steal your identity, the thieve
needs personal information like social security number, address, phone number and financial
information. So be careful when giving out any such information.
Many financial experts say that having your bills sent to you electronically and paying them
electronically is safer than sending and receiving them by mail. They also recommend shredding
paper documents with personal information. So whether you use a credit card at a physical store, you
shop and pay bills online, or you pay bills by mail, the key word is "caution." Our mothers taught us to
watch our wallets and keep the doors closed. Now we have a lot more convenience, and also a lot
more to watch out for.
PUSH Author: Sandy Berger
PUSH UG info: Compu-KISS
PUSH Date of Publication: 201 4, September
PUSH Date: 201 4, September
PUSH UG Website: Compu-KISS
PUSH File: 1 0 Tips for Shopping Online - Berger.doc
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Interesting Internet Finds – WE November 1 4, 201 4
By: Steve Costello

November 1 4, 201 4 at 11 :02 am
Tags: Interesting Internet Finds
Categories: Internet, Miscellaneous
URL: http://wp.me/p2S31 p-1 ap
Steve Costello publishes Interesting Internet Finds monthly in the Boca
Raton Computer Society’s Boca Bits monthly newsletter, and shares them through APCUG‘s PUSH
program with other computer/technology user group newsletter editors.
CLICK HERE to go to Steve's site, then scroll down the page till you find Titles, Links.Short
Descriptions of Finds .It will be about half way down the page. Once you find this section just click
on the links to see the articles.

Techie Term of the Month

Brought to you by:TechTerms.com

Menu Bar
A menu bar is a user interface element that contains selectable commands and options for a specific
program. In Windows, menu bars are typically located at the top of open windows. In OS X, the menu
bar is always fixed at the top of the screen, and changes depending on what program is currently
active. For Macs with multiple screens, OS X Mavericks (OS X 1 0.9) displays a different menu bar for
the active application within each screen.
While menu bar items vary between applications, most menu bars include the standard File, Edit,
and View menus. The File menu includes common file options such as New, OpenN, Save, and
Print. The Edit menu contains commands such as Undo, Select All, Copy, and Paste. The View menu
typically includes zoom commands and options to show or hide elements within the window.
Other menu bar items may be specific to the application. For example, a text editor may include a
Format menu for formatting selected text and an Insert menu for inserting pictures or other media
into a document. A web browser may include a History menu for reviewing previously visited
websites and a Bookmarks menu for viewing bookmarked webpages. Many programs also include
Window and Help menus for selecting window options and viewing Help documentation.
If you browse through the options in a menu bar, you’ll notice many of the items have symbols and
letters next to them. These are keyboard shortcuts that allow you to perform commands in the menu
by simply pressing a key combination. For example, the standard keyboard shortcut to save a file is
Control+S (Windows) or Command+S (Mac). By pressing this key combination, you can quickly save
an open document without even clicking the menu bar. While common commands often have
keyboard shortcuts, other menu items may not have a shortcut associated with them. These items
can only be selected by choosing the command or option within the menu bar.
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Club Officers

Below is a list of your Club officers and
their information.

Officers
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